
 

 www.microsoft.com/sharepoint 

 

 

 

 

 

 

 

 

Microsoft
®

 SharePoint
®

 2010 

Walkthrough Guide  

 

  



 

2 www.microsoft.com/sharepoint 

Copyright 

This document is provided “as-is”. Information and views expressed in this document, 

including URL and other Internet Web site references, may change without notice. You 

bear the risk of using it.  

Some examples depicted herein are provided for illustration only and are fictitious.  No 

real association or connection is intended or should be inferred. 

This document does not provide you with any legal rights to any intellectual property in 

any Microsoft product. You may copy and use this document for your internal, reference 

purposes.  

© 2010 Microsoft Corporation. All rights reserved. 

Microsoft, SharePoint, Visual Studio, InfoPath, and Visio are trademarks of the Microsoft 

group of companies. All other trademarks are property of their respective owners. 

 

  



 

3 www.microsoft.com/sharepoint 

Table of Contents 

Abstract ................................................................................................................................................1 

Introduction ........................................................................................................................................1 

SharePoint 2010 Walkthroughs .....................................................................................................4 

Accessing the virtual machine .......................................................................................................5 

Walkthrough 1: Sites ........................................................................................................................5 

Web Editing Capabilities ........................................................................................................................ 5 

Wiki Linking ................................................................................................................................................. 9 

Editing Images ......................................................................................................................................... 11 

Silverlight Web Part ................................................................................................................................ 14 

Themes........................................................................................................................................................ 17 

Media Web Part ....................................................................................................................................... 20 

Walkthrough 2: Content ............................................................................................................... 26 

Metadata and Term Store Management ........................................................................................ 26 

Metadata Filtering .................................................................................................................................. 32 

Document Sets ......................................................................................................................................... 34 

Visio Visualization for Workflow ........................................................................................................ 40 

Walkthrough 3: Communities ..................................................................................................... 43 

My Sites: Your Social Networking Hub ........................................................................................... 43 

Connecting with experts....................................................................................................................... 51 

Walkthrough 4: Working with Office 2010 .............................................................................. 54 

Word Backstage View ............................................................................................................................ 54 

PowerPoint Broadcasting ..................................................................................................................... 59 

Document Co-Authoring using Office 2010 ................................................................................. 64 

Outlook Alerts .......................................................................................................................................... 66 

Using SharePoint Workspace to Manage Offline Documents ................................................ 68 

Office Web Applications ....................................................................................................................... 71 

 



 

4 www.microsoft.com/sharepoint 

Walkthrough 5: Insights ............................................................................................................... 74 

Excel Services ............................................................................................................................................ 74 

Visio Services ............................................................................................................................................ 78 

PerformancePoint Services .................................................................................................................. 80 

Walkthrough 6: Composites ........................................................................................................ 89 

Business Connectivity Services ........................................................................................................... 89 

Customizing the List Using InfoPath Forms .................................................................................. 91 

Walkthrough 7: Search ............................................................................................................... 101 

Refining Search Results with Filtering ...........................................................................................101 

Advanced Searching in SharePoint 2010 .....................................................................................103 

Conclusion ...................................................................................................................................... 106 

Learning More ............................................................................................................................... 106 



 

1 www.microsoft.com/sharepoint 

Abstract 
This walkthrough guide is designed to provide a step-by-step overview of Microsoft® 

SharePoint® 2010.  This guide was written as a companion to the SharePoint Server 

2010 Evaluation Guide for Technical and Business Decision Makers.  We recommend 

reading that evaluation guide first, because it provides a tour of the new and improved 

features in the areas of collaboration, social computing, enterprise content 

management, search, business intelligence and composite applications.  This guide 

requires using a companion SharePoint 2010 virtual demo image.  Instructions to import 

and run the virtual demo image on Microsoft Windows Server 2008 R2 Hyper-V are 

provided on the external hard drive.   

The full spectrum of functionality and business value contained within SharePoint Server 

2010 is immense, and a detailed accounting of each feature is well beyond the scope of 

this document. This document focuses on evaluating the capabilities of SharePoint 

Server 2010 using an end-user scenario, highlighting the major functional areas that 

deliver the greatest business value.  

For the latest information about SharePoint 2010, go to 

http://www.microsoft.com/sharepoint. For other product information resources, refer to 

the Learning More section found later in the guide. 

Introduction 
SharePoint 2010 is the business collaboration platform of choice for the enterprise and 

the Internet. For every business scenario in which people need to interact with other 

people, with content and information, or with line-of-business data, the SharePoint 2010 

platform includes a rich set of integrated capabilities that are ready to be used out-of-

the-box, but can also be customized to address specific business needs and integrated 

with other products and solutions. The SharePoint 2010 platform can be deployed both 

inside the enterprise (intranets) and outside of the firewall (extranets, Internet) to enable 

interaction with employees, customers and business partners by using the same set of 

capabilities and tools. 
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SharePoint 2010 helps you to: 

Deliver the best productivity experience by letting people work together in ways 

that are most effective for them. Whether through the PC, browser, or mobile 

phone, SharePoint Server 2010 offers an intuitive and familiar user experience 

and enables people to collaborate effectively within the their current work 

context. These capabilities are significantly enhanced by the way SharePoint 

Server 2010 and Microsoft Office 2010 work together, enabling users to be more 

productive while using products and tools they are familiar with. 

Cut costs with a unified infrastructure that offers enterprise-scale manageability 

and availability. Whether deployed on-premises or as hosted services, SharePoint 

Server 2010 lowers total cost of ownership by offering an integrated set of 

features and by allowing organizations to consolidate their business-productivity 

solutions on top of SharePoint Server. This leads to a reduction in costs related to 

maintenance, training and infrastructure management. 
Rapidly respond to business needs with dynamic and easily deployed solutions. 

Whether it’s an end user, a power user or a professional developer, SharePoint 

Server 2010 offers the tools and capabilities to design and create business 

solutions that can be integrated with existing enterprise data, tools, and 

processes.  
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When considering SharePoint Server 2010 for business-collaboration solutions, there are 

six major areas to explore: 

 

 

Figure 1. Capability areas of SharePoint Server 2010 

 

Sites   The basic capabilities required to engage employees, partners and customers in 

an effective manner, both inside and outside the firewall. 

Communities   The ability to easily access expertise and interact with other people in 

new and creative ways across the enterprise through both formal and informal 

networks. 

Content   The facilities for the creation, review, publication, and disposal of content, 

including conforming to defined compliance rules, whether the content exists as 

traditional documents or as Web pages. Content-management capabilities of 

SharePoint Server 2010 include document management, records management, and 

Web-content management. 

Search   The capability to enable users to quickly and easily locate relevant content 

across SharePoint lists, sites and external systems, and other data sources, such as 

file shares, Web sites, or line-of-business applications. 

Insights   The ability to not only rapidly deliver and share information that is critical to 

the success of the business, but also to turn raw data into actionable conclusions and 

to drive business results through sharing data-driven analysis. 
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Composite applications   The ability to quickly create customized solutions without 

involving corporate IT in each request. At the same time, the IT staff needs the 

capability to empower business users to create these applications while ensuring the 

environment’s stability and availability. 

SharePoint 2010 Walkthroughs 
For this walkthrough, Contoso is a fictional manufacturing company that produces gears 

for other industries that rely on gears in their products.  You will be playing the role of 

Erika Cheley, who is a project manager at Contoso.  She has just assumed the role of 

Project Manager for one of the projects that focuses on improving the production 

process for the manufacturing of the Great White Gear product. Throughout this 

walkthrough she will be configuring the site that she will be using to work with her 

project team.  We will start the initial walkthrough as Erika makes some design changes 

to her site.  Once the site is configured, some of the new social features found in 

SharePoint 2010 will be highlighted, which members of Erika’s team will be able to 

utilize throughout their project.  Then, we will move into some content creation, utilizing 

functionality such as document libraries and lists.  After that, we’ll follow through with 

more advanced configurations such as FAST Search, workflows, and building 

connections with external data systems.   

By the time you complete this walkthrough you will have seen some of the great, new 

features available within SharePoint 2010 that, when combined together, can help meet 

everyday business needs.  Listed below is the outline of the walkthroughs.  Each 

walkthrough is a continuation of the previous one, so it is important that you start from 

the beginning and work your way through to the final walkthrough. 

 SharePoint 2010 Walkthrough: Sites 

 SharePoint 2010 Walkthrough: Content 

 SharePoint 2010 Walkthrough: Communities 

 SharePoint 2010 Walkthrough: Working with Office 2010 

 SharePoint 2010 Walkthrough: Insights  

 SharePoint 2010 Walkthrough: Composites 

 SharePoint 2010 Walkthrough: Search 
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Accessing the virtual machine 
In order to go throught this guide, you will need to setup the 2010 Information Workder 

Demonstration Virtual Machine (http://go.microsoft.com/?linkid=9728417).  The 

download center has instructions on how to setup the virtual machine.  After the virtual 

machine is setup, you will use the username Contoso\Administrator and the password, 

“pass@word1”. All users in the Contoso domain have the same password, 

“pass@word1”. 

Walkthrough 1: Sites 
With the release of SharePoint 2010, there are many new rich features available for 

configuring Sites.  These new features include the ability to edit the home page using a 

WYSIWYG (“What You See is What You Get”) editor that includes previews, the ability to 

easily add Silverlight and Media content to the site, and the ability to quickly and easily 

create relational lists for tracking content.   

One of Erika’s first tasks will be creating the team site that will be used to manage her 

project.  By utilizing a team site to manage the project, she will be able to easily 

communicate with team members and find relevant project information.  She has 

several different pieces of information she would like to include on the site, and with 

SharePoint 2010, customizing this site to meet her specific projects needs is an easy 

process. 

Web Editing Capabilities 

One of the first tasks that Erika would like to complete is customizing the project team 

site to include a project description. This will quickly identify the site purpose to any 

visitor of the project site.  She will take advantage of the wiki editing built into team 

sites.   The ribbon is used to present the different editing options.  Erika is familiar with 

the ribbon from using Microsoft Office 2007 and she will be able to easily use the 

formatting options available to add the description.   

http://go.microsoft.com/?linkid=9728417
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1. Open Internet Explorer.  The home page is set to http://intranet.contoso.com, 

which is Erika’s team site. 

 

2. Click on the System Account name in the upper right of the page, and select Sign 

in as Different User. 
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3. In the Windows Security dialog, type erikac for the User name and pass@word1 for 

the Password.  Click OK. 

 

4. The page will refresh.  In the upper right, verify that Erika Cheley appears in the 

upper right of the page, where System Account was.  You are now logged in as Erika. 

5. In the Ribbon tabs, click the Edit icon ( ) to edit the page. This will open the page 

in Edit Mode. 

 

6. Place your cursor in the first content editing area; select the Welcome to Your Site! 

text, and replace it with Gears Project Home. 

 

7. The new editing capabilities in SharePoint 2010 provide a rich editing experience 

with live preview.  Select the Gears Project Home text and change the font size to 
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18 pt. 

 

8. Move the mouse over different font sizes to see a live preview. 

 

9. Click on the font size 24 to set the font size for the title at 24pt.  Then click the Font 

Color button ( ) and change the color of the title to a different color.  Notice that 
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live preview shows you what your change will look like before committing to it. 

 

10. De-select the text to see the final result. 

 

Wiki Linking 

Now that we have the project description added to the site, Erika would like to add a 

link on the home page to the project budget workbook.  This will allow any team 

member to quickly locate the project budget workbook and find out more details 

regarding the budget of the project. 

1. Place your cursor at the end of the paragraph and press the Enter key. 

2. Type the following: Click here to view the project budget workbook:  
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3. Type [[List:S to reveal the autocomplete options that begin with “S”.   

 

4. Press the Tab key to select the highlighted item, Shared Documents/.  Note that 

the documents stored in the Shared Documents library are all listed in the 

autocomplete dropdown.  Press the Down Arrow Key until Project budget 

workbook.xlsx is highlighted. Press the Tab key again to select it. 

 

5. Close the link with two right square brackets, ]]. 

 

6. Click on the Save and Close button ( ) at the top of the page, in the Ribbon tab 

area.  You can now see the link to the project budget workbook rendered as a link 

directly to the document. 
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Editing Images 

After looking at the site, Erika decides she would like the site to reflect the Contoso 

brand and provide a graphical representation of product data.  She decides that she 

would like to add the company logo above the project description and then replace the 

standard image with a graph of the production cycle. 

1. Click the Edit icon ( ) to edit the page. 

2. Place the cursor at the beginning of the first paragraph beginning with “Add a new 

image…” and press the Enter key to insert an extra line.  Place the cursor on the 

extra line. 

 

3. In the Ribbon, click the Insert tab,  then click the dropdown under the Picture 

button and choose From Computer.  This option allows you to upload and insert a 
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picture into SharePoint in one step. 

 

4. Click the Browse button.  Navigate to C:\Demos and select ContosoLogo2.jpg, 

then click Open.  Keep the Upload to location as Site Assets and click OK. 

  

5. Click the Save button in the Ribbon of the Site Assets - ContosoLogo2.jpg pop-up.  
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6. The image is now inserted into the content.  

 

7. The Design tab under the Picture Tools heading on the ribbon becomes available 

when an image is selected.  Make sure the Design tab under Picture Tools is 

selected in the Ribbon. 

 

8. In the Design tab, change the Horizontal Size to 199 px, then click the Vertical 

Size text box. Notice the vertical size is automatically updated to keep the image in 

the correct aspect ratio (since the Lock Aspect Ratio checkbox below is checked), and 

also that the size of the image on the page has been reduced. 
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9. Click on the Save and Close button ( ) at the top of the page and you will now see 

the published version of the edited page. 

 

Silverlight Web Part 

Now that Erika has added the image to the home page, the next step is adding the 

Silverlight web part she created to display the historical production cycle of the White 

Gear product. 

1. Click the Edit button ( ) to edit the page. 

2. Click the image of the office workers and press the Delete key to delete it. 

 

3. Place the cursor in the area where the image used to be, above the Getting Started 

heading. 
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4. In the Ribbon, click the Insert tab under the Editing Tools header.  

5. Click the Web Part button in the Ribbon. 

 

6. Select Media and Content from the Categories list on the left, and then select 

Silverlight Web Part from the Web Parts list. 

 

7. Click the Add button to start the process of setting up the Silverlight Web Part. 

8. In the Silverlight Web Part dialog window, type 

http://intranet.contoso.com/SiteAssets/ZoomGraph.xap in the URL field, then 

click the OK button. This will add the pre-configured Silverlight Web Part to the 

page. 

 



 

16 www.microsoft.com/sharepoint 

9. Click on the Web Part’s dropdown menu on the far right of the Web Part’s title, and 

select Edit Web Part. (You may need to scroll the browser window to the right a bit) 

 

10. In the Web Part options pane that opens on the far right of the browser window (you 

may have to scroll the browser to the right to see it), change the Chrome Type to 

None. Click the OK button. 

 

11. Click the Save and Close button ( ) in the Ribbon to save the page. 
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12. You can now use the Silverlight control you added to the page. 

 

 

Themes 

Erika is very pleased with the changes made to the site. However, there is one final 

design change she would like to make.  The default SharePoint colors do not reflect the 

Contoso brand, so Erika is looking to apply a SharePoint theme to the site that more 

closely matches the Contoso brand.  She is able to easily accomplish this using the 

SharePoint 2010 themes developer. 

1. Click the Site Actions menu and select Site Settings. 
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2. Under the Look and Feel header, click Site Theme. 

 

3. The Site Theme page allows users to easily change a site’s colors by selecting a 

theme from an available list of themes. 
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4. Select the Azure theme from the list of themes. 

 



 

20 www.microsoft.com/sharepoint 

5. Notice that you can also customize the theme by selecting individual colors and 

fonts. 

 

6. Scroll down the page and click Preview button  to preview the 

theme. A new browser window will open with the new theme applied to the site. 

 

7. Close the preview browser window. 

8. Click the Apply button  to apply the theme to the site.  

 

Media Web Part 

As Erika reviews the home page, she determines there is sufficient content on the home 

page and that adding additional content will cause issues with the ease of navigation.  

However, she would like to display a video of the current manufacturing process.  This 

will be an important training video for all members of the project, but, by adding it to 

the home page she could potentially cause some distraction to her team members.  So, 
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instead of adding it to the home page, Erika decides to create a new page dedicated to 

the video and the media web part to display the video. 

1. Click Gears Project Home in the site breadcrumb. 

 

2. Click the Site Actions menu and select New Page. 
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3. In the New Page dialog, enter the name New Media for the page and click Create. 

 

4. When the new page opens, click on the Insert tab in the Ribbon, then click the 

Video and Audio button. 

 

5. This will add the Media Web Part to the page content area. 

 

6. Click on the Media Web Part. 
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7. This will reveal two new headers in the Ribbon, Web Part Tools and Media, with 

Options tabs under each one. 

 

8. In the Options tab under the Media header, click the dropdown under the Change 

Media button and choose From SharePoint. 
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9.  This opens the Select an Asset dialog window. 

 

10. Select the Site Assets folder in the left pane, then select the Gears video in the right 

pane.  Click OK to add the video to the Media Web Part.  

11. Click the Play button. The video will start playing.  It is important to note that 

SharePoint 2010 is streaming this video. 

 

12. Click on the Save and Close button ( ) in the Ribbon to save the page.   
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In this walkthrough you have seen how easily Erika is able to make customizations and 

design changes to her team site. Now she is ready to invite the members of her team to 

the site to begin collaborating on the Gears project.  Without needing any assistance 

from the IT Department, she has been able to modify her sites home page, update the 

site image, change the theme, and link to several different project media files.   

  



 

26 www.microsoft.com/sharepoint 

Walkthrough 2: Content 
Now that Erika has spent some time designing her site, she is ready to move on to the 

creation of content for her team site.  She has a few specific things she would like to 

configure, including a custom order tracking solution, some document library 

configurations, and some workflows.  She has spent some time reviewing the newest 

features available within SharePoint 2010 and she knows that she will be able to take 

advantage of the new features, such as Managed Metadata and Document Sets.  In this 

walkthrough, we will cover the different items she will need to configure to get the site 

ready for the team to start adding content.  

Metadata and Term Store Management 

The next item that Erika would like to configure for this team site is the ability to tag 

documents based on the various regions of the company.  By tagging documents this 

way, she will be able to ensure that they can easily be found and referenced in the 

future.  Erika will be using the new Managed Metadata features to configure this 

functionality.  She will begin by importing some hierarchical terms for regional 

information into the Term Store. 

1. Click the Site Actions menu and select Site Settings. 

2. Under the Site Administration header, click Term store management. 
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3. In the Taxonomy Term Store pane on the left, right click Site Collection – 

intranet.contoso.com node of the tree to show the dropdown menu. Select 

Import Term Set from the dropdown menu. 

 

4. Click the Browse button. 

5. Navigate to C:\Demos and select the RegionInfo.csv file and click Open. 

6. In the Term Set Import dialog, click OK.  The data from the text file will be 

imported into the SharePoint Term Store. 

 

7. If you receive a the pop-up stating that some terms were not imported 

successfully, click OK.  (This will not affect this walkthrough.) 
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8. Expand the new Office Locations node and terms in the term hierarchy.  It now 

contains a sample continent / state / city hierarchy for tagging items.  

 

9. Click the Site Actions menu and select View All Site Content. 

10. Click on the Shared Documents library link. 

 

11. Click the Library tab in the Ribbon. 

 

12. On the Ribbon, click Create column. 
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13. Name the new column Office Locations, and select Managed Metadata as the 

column type.   

 

14. Check the Allow Multiple Values option. 

 

 

15. Scroll down to the Term Set Settings section.  Type Office Locations in the Use 

managed term set field, and click the Find button ( ).  The Office Locations 

term set will appear in the box below the text.  Click Office Locations to select 

the term set. 

 

16. Click the OK button at the bottom of the Create Column screen to add the new 

column. 

17. In the Ribbon, click the Library Settings button. 
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18. Under General Settings, click the Metadate navigation settings link. 

 

19. In the Configure Navigation Hierarchies section, select the Office Locations 

hierarchy field and click the Add button. In the Configure Key Filters section, 

select each available key filter field and click the Add button.  Click the OK button 

at the bottom of the page. 
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20. Click Shared Documents in the breadcrumb, at the top of the page, to return to 

the default list view of the Documents library. 

 

21. Click the dropdown menu for Project budget workbook and select Edit 

Properties.  
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22. In the Office Locations field, type the text New and pause for a moment to see 

the suggested tags appear.  Select the New York tag.  

 

23. Click Save. 

 

Metadata Filtering 

Now that Erika has the list configured for tagging with Managed Metadata, she is going 

to take advantage of the Metadata filtering options to configure some filters for the 

document library.  This will allow the project team to quickly find items in the library 

based on a tag. 
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1. In the default view of the Shared Documents library, notice the Navigation 

Hierarchy Filtering control is now available in the left navigation area. 

 

2. Expand the Office Locations node, locate New York, and click on it. 

 

Scroll the page up to see the documents in the list.  Notice that only the Project 

budget workbook document appears in the list, since you just tagged this 

document with New York and filtered by the New York office location. 

 

3. Return to the Navigation Hierarchy Filtering control and select the Shared 

Documents node to clear the filter. 
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4. Now that metadata filtering is cleared, all documents are displayed again. 

 

5. Below the navigation hierarchy filtering control (you may need to scroll the page 

down), you will find the Key Filters panel, which acts in a similar fashion. You can 

filter on any of the columns listed in the panel.  Typing in the metadata field will 

bring up the autocomplete suggestions, similar to editing the properties of an 

item and adding metadata tags. 

 

You should experiment with this feature, selecting different fields to use as key 

filters.  In practice, you would select the method most suited to the content 

within the library for filtering items. 

Document Sets 

The new Document Set feature in SharePoint 2010 allows the management of entire 

groups of documents as aggregate entities.  For example, you can check out an entire 

document set, which will then check out each of the documents contained in the set.  
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Erika would like to incorporate this into her team site so that all the documents 

providing an overview of the Great White Gears product can be tracked as a single item. 

1. From the Shared Documents library default view, click the Library tab and click 

the Library Settings button. 

 

2. Under General Settings, click on Advanced Settings. 

 

3. For Allow management of content types click Yes.  Click OK to return to the 

Library Settings page. 

 

4.   Under the Content Types section, click Add from exiting site content types. 
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5. In the Select site content types from dropdown, select Document Set Content 

Types, select Document Set in the box beneath it, and click the Add button. 

Click OK to add this content type to the Documents library. 

 

6. Return to the standard view of the Documents library by clicking on Shared 

Documents in the breadcrumb. 

 

7. In the Ribbon, click on the Documents tab. 
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8. In the Ribbon, click the dropdown below New Document and select Document 

Set. 

 

9. For the Name, type Great White Gears.  In the Description field, type 

Documents related to Great White Gears.   Click OK. 

 

10. A new document set has been created.   
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11. Click on the Documents tab in the Ribbon. 

12. In the Ribbon click the dropdown below Upload Document and select Upload 

Multiple Documents to upload some documents into the document set. 

 

13. Open Windows Explorer and browse to C:\Demos.  Select Great White 

Overview.docx and Great White Gear - Customer Agreement.docx 

14. Drag and drop them into the Upload multiple documents dialog. 
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15. Click OK to begin the upload process, when the process is complete click Done 

to close the upload window.   

 

16. In the Ribbon, click the Browse tab, then click the Shared Documents link in the 

breadcrumb to return to the default view of the Documents library.   

You have now created a document set named Great White Gears and added a 

couple of documents. You can add as many documents as you wish to the document 

set, which will operate as a single entity within the document library.  

 

In this walkthrough you have seen how easy it is for Erika to create the different lists and 

libraries that her team will be using for project collaboration.  With the new features 

such as Document Sets and Managed Metadata, Erika has been able to create solutions 

that will provide consistency across all documents.  These small changes will make a big 

difference for her team as they work together to collaborate on many different types of 

project documents. 
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Visio Visualization for Workflow 

Managing processes and tasks is an essential part of any team working together.  While 

previous versions of SharePoint have included workflow options, they don’t compare to 

the improvements available with the release of SharePoint 2010.  By combining 

common tools, such as Visio and SharePoint Designer, users are able to create 

workflows that empower them to collaborate and generate content.  In this 

walkthrough, Erika is going to be configuring workflows within the site to manage the 

approval of documents.  Erika wants to be able to route the documents for approval and 

then be able to view the status of the documents’ approval.  By using the built in 

workflow template she will be able to manage this process without needing to be 

constantly tracking down members of the project team to receive the approval.   

SharePoint 2010 now contains the capability to visualize workflows using Visio 2010.  (In 

the next section you’ll see how to design workflows using Visio.)  You’ll assign a 

workflow to a document and view its status as a visual diagram. 

1. In the Shared Documents library, click the dropdown menu for the Great White 

Gears Production Specs document and select Workflows. 

 

2. Under the Start a New Workflow header, click Approval – SharePoint 2010. 
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3. You are presented with a form to complete to start the workflow on the Great 

White Gears Production Specs document.  Type contoso\erikac in the Assign To 

field.  Click the Check Name icon ( ).  In the Request field, type Approval 

workflow test.  Click the Calendar Icon ( ) next to the Due Date for All Tasks 

field and select July 15, 2010.  Click Start. 

 

4. Note that a column displaying the progress of the current workflow has been 

added to the current view of the Documents library, and it indicates In Progress 

for the Welcome to Gears document.  
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5. Click on the In Progress link in the Approval - SharePoint 2010 column. 

6. The Workflow Status page opens, and after a few moments a Viso diagram 

showing the overall workflow and its current status is displayed.  With your 

mouse cursor, you can click and drag the diagram inside the window to view 

different areas of the workflow, and zoom in on the diagram to focus on smaller 

portions of the process.  You can also open this diagram in Visio 2010.  
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Walkthrough 3: Communities 
One of the key drivers today for any business is efficient interaction between their most 

valuable resources: employees. In SharePoint 2010, the social experience is integrated 

into all facets of the product, giving employees the information and tools they need to 

make connections and work more effectively throughout the collaborative environment.  

In this walkthrough, you will take a tour through key social features found in SharePoint 

2010.  Erika would like to find additional information regarding other process 

improvement projects at Contoso and any related information regarding gears that her 

team may find valuable. Using the social features in SharePoint 2010, you will see just 

how quickly Erika can tag content, provide social feedback, search for content, find 

experts and network with others. 

My Sites: Your Social Networking Hub 

Erika is interested in any additional process improvement projects at Contoso.  She 

knows that Tad Orman works on product improvement projects and would like to 

connect with him to learn from his experience with previous projects. 

1. Click Search in the top navigation.   

 

2. Above the search box, click the People tab to perform a people search. 

 

3. Type Tab in the search box and press enter. 
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4. The first person listed is Tad Orman,. SharePoint has built in phonetic name 

matching. So even though you searched for “Tab” it found Tad. Click the By Tad 

Orman link to see content recently created by Tad. 

  

5. Now, click Browse in organizational chart to find where Tad is within the 

company. 

  

6. The organization chart is a Silverlight control that makes navigating through the 

company’s employees easy.   
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7. In the bottom left corner of the Organization tab, click on the HTML View link. 

This provides a more traditional look at the organization, and is also the default 

experience seen by users accessing the site without Silverlight enabled browsers. 

  

8. Scroll up the page to discover more information about Tad. Above Tad’s picture 

you see his status update that he is currently brainstorming process 

improvements for the Vulcan Gears. 

 

9. Click on the More information link in his profile details. Here you can see 

additional information about Tad.  
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10. Click the Overview tab.  Under Recent Activities, you will see Tad has been very 

active updating his profile and tagging content. Scroll to the bottom of the 

section to find his Note Board. In the Note Board field, type Tad, I would like 

to discuss your ideas for improving the production of the Vulcan Gears. I am 

currently managing a process improvement project for Great White Gears. 

Click Post.  

 

11. Erika also believes it will be helpful for her team to understand how the gears are 

marketed.  It is important to understand the key features and functionalities 

being promoted to the customer in order to ensure the process improvements 

do not reduce quality in those areas.  She remembers that Tad also participated 

in a marketing project for Gears and decides to start by looking for information 

on it. Scroll back up the page and click on the Tags and Notes tab. 

 

12. Under the Refine by tag: filter, click Gears to refine the list by items tagged with 

“Gears.” 
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13. Now you only see the activities for Gears. Click on View Related Activities for 

the Gears Marketing Project -… (second item) in the list. 

  

14. In the pop-over window, you will see that you and John Evans have previously 

tagged Tad’s blog post as “Product Review,” someone else had used the tag 

“preferred partner,” and Tad tagged the post with “Gears.” Close the pop up 

window, using the X in the top right-hand corner. 

 

 

15. Click on the Content tab.  Click on Tad’s blog post called Gears Marketing 

Project, to read about the status of the Gears project.   
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16. In the blog post, there is a link to view the presentation called “Gears 

Marketing-Project Status.pptx”.  This presentation will be a valuable resource 

for the team. 

 

17. In SharePoint 2010, tagging content makes it easily referenced and discovered by 

other SharePoint users.  Next, you decide to tag the blog post with the word 

“Gears”, since it is relevant to the Gears project.  At the top right hand corner of 

the blog post, click the Tags & Notes button. 

 

18. Under Suggested Tags, click Gears and select Add to My Tags. 

 

19. Click Save. 

20. Since you are interested in the topic of the Gears project, you can view what is 

called the Tag Profile for this tag.  Click Gears again, and click Go to Tag Profile 

for Gears. 
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21. This page displays a feed of all content that has been tagged with the word 

“Gears”.  You can use the links in the Get Connected section for this tag to keep 

up to date with the tag, as well as leave notes about it on the Note Board. Click 

Follow this tag in my newsfeed in the Get Connected section. This will make it 

very simple for Erika to keep up with Gears updates in the future.  

 

22. You will now create a reference to the project in the FAQ Wiki site.  Under the 

Tagged Items section, right-click on the link Gears Marketing-Project Status 

and choose Copy Shortcut to copy the link to Tad’s blog post. 

 

 

23. To get to the project home page, click Gears Project Home at the top of the 

page.   

 

24. Click the FAQ Wiki link in the top navigation.  This is where you will add the link 

to Tad’s presentation.  
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25. Click on Where is the Gears Marketing material link. 

 

26. In the Ribbon, click the Edit icon. 

 

 

27. Click the Insert tab.  Then, click the dropdown under the Link button and select 

From Address. 

 

 

28. In the Text to display field, type Gears Marketing by Product.  Then, paste 

(Ctrl+V) the hyperlink you copied from Tad’s My Site into the Address field.  

Click OK.  
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29. Click the Save and Close icon in the Ribbon. 

 

30. In the Ribbon tab area, click the Navigate Up ( ) icon and select Gears Project 

Home from the hierarchy list to return to the home page of the site. 

 

 

Connecting with experts 

Using the social features in SharePoint 2010, Erika is able to find Tad and discovers she 

is likely to consult with him in the future. Erika decides she would like to connect with 

Tad to allow her to stay up to date with the different activities Tad is involved in, and 

vice versa. Erika had received an email that Tad posted a note on her Note Board, so she 

decided to check it out. 

1. Click Search in the top navigation. 

2. Click the People tab. 

3. Type Erika in the search box and press enter. 

4. Take a look at the Help people find me section right below Erika’s profile. This 

new section provides Erika with feedback on how other people are discovering 
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her using search. Click on Erika Cheley.

 

5. Scroll down the page to the Overview section and look at the Note Board. Click 

on the presence icon next to Tad Orman. Click X to close the popup box.   

 

 

6. Click on Tad Orman’s name to open his My Site. 

7. In Tad’s My Site, click on Add as colleague beneath Tad’s picture. 

 



 

53 www.microsoft.com/sharepoint 

8. This will open a pop over window, where you can make settings for how you see 

your new colleague. Accept the defaults and click OK.  

 

9. Click OK at the Message from webpage popup. 

 

Erika and Tad have now made a connection and have grown their internal networks. 

Erika will now be able to see Tad’s updates in her news feed. 

In this walkthrough you explored the social side of SharePoint 2010 and how it helped 

Erika discover additional information about gears. You also saw how Erika connected 

with Tad through a blog post.  Erika was able to find Tad’s expertise through the simple 

act of performing a search, which will allow both of them to stay informed and in-touch 

when working on related projects. 

  



 

54 www.microsoft.com/sharepoint 

Walkthrough 4: Working with Office 2010 
One of the benefits of working with SharePoint is taking advantage of the rich 

integration features available with other Microsoft Office applications.  With each 

release of SharePoint, the integration story improves greatly, and with the release of 

SharePoint 2010 we have access to many more integration features with Office 2010.   

Erika has read about the powerful integration between Office 2010 and SharePoint 2010, 

and decides to test some of the new features, including the new Office Backstage, 

PowerPoint broadcasting options, Alerts, and SharePoint Workspace.  In addition to the 

role of Erika, you will also log onto the site as Justin Thorp, one of her project team 

members.   

Word Backstage View 

The first new feature that Erika looks at is the new Office Backstage view.  She decides to 

try it out by editing a Microsoft Word document, although the same concepts can be 

applied to all of the Office client applications. 

1. Return to the home page of the site by clicking Gears Project Home in the top 

navigation. 

2. Click Shared Documents in the left navigation. 

3. Click the Great White Gear document set. 
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4. Select the dropdown option for Great White Gear - Customer Agreement and 

select the Edit in Microsoft Word option. 

 

 

 

5. When the Open Document dialog appears, click OK.  

 

 

6. Once you have the document opened in Word, select the File tab to open Office 

Backstage.  This new feature provides a “backstage” view, which provides you 

with quick and easy access to information about the document as well as 

providing menus for common document tasks. 

 

7. From the Backstage view you will be able to perform some of the same actions 

you can perform in the browser.  Click the Manage Versions button and select 

the Check Out menu item.  This will check out the document to you so that no 

other users will be able to work on the document while you have it checked out.   
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8. Click the File menu again, and notice that a new menu item has appeared which 

allows you to Check In the document or discard the Check Out. 
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9. In the Backstage view, you can also update the document’s metadata.  In the 

right pane of Backstage, click the Show All Properties link.  
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10. Click Enter a choice next to Office Locations  

 

 

11. Type Den, and when the Suggestions box displays Denver, press Enter to accept 

the autosuggestion. 
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12. Click the Check In button at the top of the page and click OK on the Check In 

dialog. 

 

13. Close Word and switch back to the document library open in SharePoint.  You 

will notice that the Modified date and time has been updated, and the Office 

Locations column is now set to Denver.  Also note that the information updated 

automatically, without even having to refresh the browser.  

 

 

PowerPoint Broadcasting 

Often times, as a team works together, there is a need to share a presentation to 

many different users at one time.  New features inside PowerPoint allow SharePoint 

to be used as a broadcast location for presentations.  This means that no matter 

where the team is located, they can easily view the presentation through the 

browser.  Simply select the SharePoint site at the broadcast location and a link will be 
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provided that can be shared with users to access the presentation.  Erika will use this 

functionality to share with the project team the Contoso’s Most Resilient Gear 

presentation.  

1. In the left navigation, click Shared Documents 

 

2. Click the dropdown for the Contoso’s Most Resilient Gear PowerPoint 

Presentation and select Edit in Microsoft PowerPoint.  When the Open 

Document dialog appears, click OK 

 

 

3. Once the presentation opens in PowerPoint, select the File tab to open the 

Backstage view. 
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4. Click the Save & Send category and select the Broadcast Slide Show link. 

 

 



 

62 www.microsoft.com/sharepoint 

5. Select Broadcast Slide Show  

 

6. On the Broadcast Slideshow window, click Change Broadcast Service 

 

 

7. Click Add a new service… and type 

http://intranet.contoso.com/sites/broadcast in the Add Broadcast Service 

field.  This is a specialized site collection that enables PowerPoint slideshows to 

be broadcast from SharePoint.  Click Add. 
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8. On the Broadcast Slideshow window, click Start Broadcast. 

 

 

9. After a few moments, you will receive a link that can be sent to your colleagues to 

view the broadcast.  Click Start Slide Show 
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10. The slideshow begins in full screen mode.  At any time, you can press the Esc key 

to end the full screen broadcast.  To end the entire broadcast and disconnect any 

users connected; click the End Broadcast button in the notification bar below the 

Ribbon. 

 

11. Click End Broadcast on the pop-up dialog that appears. 

12. Close PowerPoint. 

 

Document Co-Authoring using Office 2010 

When using the powerful integration features of SharePoint 2010 and Office 2010, users 

have the capability to work together as simultaneous co-authors on the same Word 

document.   

From within a SharePoint document library, a team member can open the document in 

Microsoft Word 2010 and begin editing.  Another team member can open the same 

document in Word 2010 and simultaneously edit the paper.  Word 2010 locks sections 

being edited by a user to prevent their work from accidentally being overwritten.  To 

update the document with changes and additions made by everyone working on it, each 

user simply saves the document and the changes are reflected in the document 

instantly.   
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Instead of relying on each user to open the document and make updates individually, 

the co-authoring features allow for real-time team collaboration needed for efficiently 

managing a document. 

Erika is authoring a document, and asks one of her team members to help out.  As she 

works, she receives a notification that he has joined her in editing the document.  She 

can click the User icon in the bottom of Word 2010 to see everyone working on the 

document.   

 

Erika continues working and saves her changes. 

As her team member makes changes, he saves them also.  Erika notices that updates are 

available in the bottom panel of the Word window. 

 

 She clicks the Save button in the Quick Access toolbar and her team member’s changes 

are reflected in her document and are highlighted in green. A notification window lets 

her know this as well. 
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Outlook Alerts 

Another key benefit of SharePoint and Office integration is the ability to receive email 

alerts whenever content is created or updated.  These alerts allow the flexibility of 

seeing content changes without having to access the SharePoint site.  Erika knows this 

could be a very helpful feature to utilize since there will likely be many changes to site 

content and documents throughout the project’s lifecycle.  Since these alerts are 

configurable, she can select the combination of options that best fits her needs.  

Within a document library or list, an email alert can be assigned to individual documents 

or to an entire library or list.  Below, Erika is about to configure an alert on a selected 
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document by using the SharePoint Ribbon. 

 

Alerts are customizable, so you have the ability to choose whether you are alerted every 

time anything changes in the library, only when new items are added, when existing 

documents are modified, or when items are deleted.  This way Erika won’t have to 

actively monitor SharePoint to know what is going on with the project.  In the 

screenshot below, Erika is setting up an alert so she will be notified when anything 

changes in the Shared Documents library. 
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Once an alert has been created, it can be monitored in Outlook 2010 from the Manage 

Rules and Alerts option in the Ribbon.  Additionally, alerts can also be managed from 

within SharePoint as well. 

Using SharePoint Workspace to Manage Offline Documents 

SharePoint Workspace (formerly known as Office Groove), a new addition to the Office 

clients, provides an easy way for users to take SharePoint content offline and then sync 

the content back to the server once they are online again.  Erika will be offline for a long 

weekend.  Since this long weekend occurs during the project’s busy phase, she knows 

she will need to have access to the documents while she is away.  Using SharePoint 

Workspace, she is able to pull her documents offline before leaving for her trip.  When 

she returns to the office after her trip, she is able to easily sync the documents back to 

SharePoint. 

1. Switch back to the browser and navigate to the Shared Documents library   

2. Select the checkbox next to the Great White Gears document set.  

 

3. In the Ribbon, click the Library tab, then click the Sync to SharePoint 

Workspace button. 

 

 

4. The Account Configuration Wizard will open.  Leave Create a new account 

selected and click Next. 
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5. In the Name field, type Erika Cheley.  In the E-Mail Address field, type 

erikac@contoso.com.  Click Finish.  

 

 

6. When the Sync to SharePoint Workspace dialog opens, click OK. The sync will 

begin. Once all supported items are completed, select the Open Workspace 

option. 
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7. Select the Great White Gears document set.  You will see that all the documents 

and their associated metadata can now be opened from the Workspace and 

accessed while offline. 

 

 

8. In the SharePoint Workspace Ribbon, click the Sync tab. Click the dropdown 

under Sync, then click Sync Workspace to sync the workspace back to 

SharePoint. 
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9. Close SharePoint Workspace. 

 

In this example, you learned how easy it is to take content within SharePoint and work 

with it offline. The SharePoint Workspace is not limited to this type of configuration.  To 

learn how you can use SharePoint Workspace for other offline scenarios you can refer to 

the following TechNet documentation: http://technet.microsoft.com/en-

us/library/ee649106(office.14).aspx  

Office Web Applications 

One of the final feature sets that this walkthrough will cover is the addition of the Office 

Web Applications (OWA).  The Office Web Applications allow for certain documents to 

be rendered and edited in the browser.  The OWA client supports Word, Excel and 

PowerPoint documents.  Users are able to access these types of documents directly in 

the browser without needing to have the client installed locally.  The IT department has 

already installed the OWA clients on the SharePoint server, and Erika is excited to try 

them out.  OWA utilizes the security permissions configured within SharePoint, so any 

user that has contribute rights to the site will also have the ability to modify documents 

using the OWA features.   

1. Switch back to Internet Explorer.  Click on the Great White Gears document set. 

2. Click the dropdown menu for Great White Overview and select the View in 

Browser option.  This will open the document using Office Web Applications.  

From this screen you are able to view the document, switch to edit mode, or 

select to open the document within the full Word client. 

http://technet.microsoft.com/en-us/library/ee649106(office.14).aspx
http://technet.microsoft.com/en-us/library/ee649106(office.14).aspx
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3. The document opens in The Office Word Web Application.  Click Edit in Browser.  

Once the document has been placed in edit mode, the Ribbon appears and is 

similar to the full Word client. 

 

 

 

4. Click File > Save to save the document.  

 

 

5. Click Gears Project Home in the navigation breadcrumb to return to the home 

page. 
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In this walkthrough we have covered just some of the great new Office integration 

features available within SharePoint 2010.  Using these different features will allow users 

to work more efficiently with business data, no matter what system they are working 

from.  And with so many different options to choose from, users are no longer limited to 

only working at the office or while connected to the Internet.   
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Walkthrough 5: Insights 
Now that Erika’s team site has been configured, she has gotten some great feedback 

from the team and is ready to move forward with a few more customizations.  A few 

team members have provided feedback that it would be great if they only had to go to 

one location to access all the content they need when working on the project.  Based on 

the feedback, Erika worked with the IT department and determined that she could 

proceed with using some of the new business intelligence features in SharePoint 2010 to 

accomplish her goals.  Specifically, she wants to be able to display some supplier 

information from an external system within the team site,display some Excel Services 

information directly on the team site and use the PerformancePoint dashboards to help 

her make business decisions based upon performance metrics and trends.  Throughout 

the remainder of this walkthrough, we will walk through the process of completing these 

tasks. 

Excel Services 

Erika is going to create some Excel Services web parts to display some of the project 

data directly on the new site she created. 

1. Click the Shared Documents link in the Left Navigation. 

2. Click the dropdown menu for Gears Sales History and select View in Browser. 
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3. The document will open in the browser using Excel Services. Click the Open in Excel 

button toward the top of the screen. 

 

4. On the Open Document dialog, select the Edit option and click OK.  The file will 

open in Excel 2010. 
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5. Scroll to the right and select cells L4:M30 (see screenshot).   

 

6. In the Ribbon, click the Insert tab.  Click the Pie dropdown and select a 2-D Pie 

chart type.  A pie chart will be inserted into the document. Position and stretch this 

chart to fill the blank space to the left of the data table. 
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7. Click on the Save button in the Quick Access toolbar (above the File tab) to save the 

file back to the SharePoint library. 

 

8. Close Excel and return to the browser, which should still be displaying the Gears 

Sales History workbook in Excel Services.  Click File > Reload Workbook.  Click Yes 

on the dialog asking if you want to perform this action.   

 

9. The workbook is refreshed and the newly-modified chart is now displayed in Excel 

Services. 
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Visio Services 

Next, Erika would like to make some updates to a SharePoint list, which is actually a 

connection to supplier’s data which is stored in a SQL database.  Since this information 

is important to the project, Erika asked her IT administrator to create the connection for 

her.  Now, the project team only needs to visit one location in order to view or update 

the supplier data. 

1. Navigate back to the home page of the site. 

2. Click the Supplier Information link in the left navigation.  The data appears just like 

any other SharePoint list, however, it is dynamically connected to the Suppliers table 

in the SupplyChainSQL database, which is not actually a SharePoint database. 

  

3. Click the dropdown menu for item 10 in the ID column.  Select Edit Item. 

 

4. Change the value of the Assembly Time(M) field from 15 to 25.  Click Save. 
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5. The value is now changed in the list.  Note that this has also changed the value for 

this item in the Suppliers table in the SupplyChainSQL database. 

 

6. In the left navigation, click Shared Documents. 

7. Click the dropdown around SupplyChain_v3.vdw Visio document and select Edit in 

Microsoft Visio.  Click OK on the Open Document dialog. 

 

8. When prompted, click Enable Automatic Refresh.  When Automatic Refresh is 

enabled, the data will automatically refresh every 3 minute (this interval is 

configurable in the Data Refresh dialog). Click OK on the Microsoft Visio Security 

Notice dialog. 

 

9. Zoom in on the graphic labeled Cover and Lube (just to the upper right of the 

center of the diagram).  The new value you entered in SharePoint (25) is reflected in 

the Visio diagram, which is also dynamically connected to the SupplyChainSQL 
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database. 

 

PerformancePoint Services 

Next, Erika would like to take a look at a performance dashboards to view key 

performance metrics, trends and efficiencies that can help her with this project.  

PerformancePoint Services makes it possible for business users to see the information 

they need in an aggregated environment giving them the information they need to 

make informed business decisions. 

1. Enter http://intranet.contoso.com/bi in the browser and press Enter to go to the 

Business Intelligence Center, an out of the box template that provides 

information and samples of how to use the BI components in SharePoint. 

2. Click on Dashboards in the Quick Launch and then again on the Adventure 

Works 2010 demo folder. 

http://intranet.contoso.com/bi
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3. Click on Summary.  This loads the dashboard which displays a corporate 

scorecard and strategy map outlining how we are performing and aligning to our 

corporate strategy. 
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4. Click on the first icon on the scorecard view (Filter by Status) and select Off 

target.  You can quickly see what on or off target and where to focus your 

attention. 
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5. Click on Sales Detail Dashboard.  This is an operational view of the business.  

There are a variety of items here that you can interact with to understand how we 

are performing, which are the top 5 products, and our most profitable products. 
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6. In the bottom chart (Gross Profit Margin).  On the first bar, right click on the light 

blue bar and select remove.  We know that mountain bikes are selling well, but 

also want to see other items that might be performing so we will remove 

Mountain Bikes and find that Touring Bike are also moving.  Right click again on 

the blue bar (now for Touring bikes) and select decomposition tree.  This allows 

us to view the data in a unique way by decomposing the data and enabling you 

to slice and dice the data across any dimension of the business. 
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7. From the top product item, click on the item (835K Touring-1000) and then click 

on Sales Channel. 
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8. Click on Sales Channel and then select Sales Territory and then Country.  We 

are looking at touring bikes sold through our various channels for particular 

countries.   
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9. Now select the + sign next to one of the items (i.e. 297K United States - if you 

don't see the + sign, select the item (click) and it will appear to the left of the 

item). You are now drilling into the country down to each region for the 

highlighted item. 

 

10. Now that you have this path, you can do exactly the same for another product 

item.  Select the next product down by clicking the + sign (again, click on the 

item and then select the plus sign). 

 

This walkthrough provided a tour of the new business intelligence capabilities in 

SharePoint 2010.  As you have seen in the examples, Erika was able to view and edit an 

Excel worksheet using a browser, connections to external data can be established via a 
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graphical user interface, without the need to write code and rich dashboards provided 

her insight into business data and allowed her to find identify trends to make informed 

decisions.  Erika was able to configure a site for her team that allows them to have a 

single point of access for all the data they need for their project.  
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Walkthrough 6: Composites 
Now that Erika has configured the document libraries for her sites, she would like to 

spend some time focusing on the lists that she will use on the site.  She has decided that 

she would like to create a custom contacts list.  She knows this can easily be done within 

SharePoint, however, she isn’t pleased with the formatting of the list form.  Since she is 

using SharePoint 2010 she is going to take advantage of the new Composites features 

and use InfoPath 2010 to customize the list form.   

In SharePoint 2010, the term Composites refers to the capability to produce composite 

enterprise solutions using combinations of out-of-box features, without having to 

custom-build applications involving custom coding and development resources.  This 

will allow Erika to rapidly implement a custom form using InfoPath Designer 2010.   

Business Connectivity Services 

The first thing that Erika will need to do is to create the contacts List.  Once the list has 

been created she will be able to easily select the option to customize the list form using 

InfoPath from the Ribbon.  Since Erika has all the tools installed on her desktop, she 

won’t need any assistance from the IT department to make the needed customizations. 

 

1. Navigate to the home page of the site. 

2. Click the Site Actions menu and select View All Site Content. 

 

3. Click Create. 
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4. In the left side of the Create dialog, click List under the Filter By header. 

 

5. Select the Contacts template.  Type Contacts in the Name field and click the Create 

button. 

 

6. Your new Contacts list is displayed. 

 

7. Click Add new item to preview the form.  This is how the form looks out of the box, 

without customization.  Click Cancel to close the form.  You will be designing a more 
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visually appealing form in the following steps. 

 

Customizing the List Using InfoPath Forms 

Now that the list has been created, Erika will use the options available within the Ribbon 

to open the form in InfoPath so that it can be customized.  Once her changes have been 

made to the form, she will publish the form from InfoPath back to the SharePoint list. 

1. On the Ribbon, click the List tab. 

 

2. Click on the Customize Form button. 
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3. InfoPath 2010 will open and display the form in its default view.   

 

4. Place the cursor in the table cell containing Full Name. Right-click in the cell and 

select Delete > Rows 
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5. Select the rows containing Home Phone, Mobile Number and Fax Number.  Then, 

right-click in any of the highlighted cells and select Delete > Rows. 

 

6. In the InfoPath Ribbon, click the Page Design tab. 

 

7. In the Themes group, select the Bittersweet theme (4th from the left).  

 

8. Click the Home tab in the Ribbon. 
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9. Place the cursor in the Last Name cell. Right-click the cell and select Insert > Rows 

Above. 

 

10. With the two new empty cells selected, right-click and select Merge Cells. 

 

11. With the newly merged cell selected, click the Title font style in the Ribbon. 
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12. In the top row, type Contact Information. 

 

13. Select the Business Phone field control, and on the Ribbon double check you are in 

the Control Tools  header then click Manage Rules. 

 

14. The Rules pane opens on the right.  We will set a rule to validate the number 

entered into the field as a phone number.  In the Rules pane, click New > 

Validation. 
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15. In the Details for text box, change the default name “Rule 1” to Phone Number.  

Click the link None below Condition: to add a new condition. 

 

16. Set the first condition to the Business Phone > is not blank and click the And>> 
button. 

 

17. Set the second condition to Business Phone > does not match pattern > Select a 

pattern…
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18. Select Phone number from the Standard Patterns list. (Note that the pattern 

includes a space after the area code) Click OK. 

 

19. To allow for no space after the right parenthesis, create a custom pattern.  Click the 

And >> button after the second condition and set the third condition to Business 

Phone > does not match pattern > Select a pattern. 

20. With Phone Number preselected, place the cursor in the Custom Pattern box and 

delete the space following the right parenthesis.  The pattern should now be 

\(\d\d\d\)\d\d\d\-\d\d\d\d. Click OK. 

 

21. Click OK to close the Condition dialog. 
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22. In the ScreenTip box in the Rules pane, type Not a valid phone number:. 

 

23. Publish the new form by clicking the Quick Publish button ( ) in the InfoPath Quick 

Access Toolbar. 

 

24. When you receive a message indicating that the form was published successfully, 

click OK. 

25. Switch back to the browser and click Add new item. 
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26. You will now see the newly-customized form. 

 

27. Test the Business Phone validation by typing Random text in the field. Press the 

Tab key to move to the next field and validate the Business Phone field.  A red 

border will appear around the field indicating there is a problem.  

28. Hover the mouse cursor over the Business Phone field to see the ScreenTip. 

 

29. Change the phone number to a valid number that matches one of the patterns you 

set up in previous steps.  When you select a new field to type in, the red border 

around the incorrectly formatted field will disappear, indicating your entry is valid.  
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Click Close to leave the new item form. 

 

You should experiment with more features available in the InfoPath 2010, such as: 

 Adding actions that will set another field’s value based on a condition 

 Produce a dialog box message based on a condition 

 Embedding graphics (corporate logos etc.) into the form 

 Using different field controls, such as Check Boxes, Date Pickers, etc. 

 Using data from other locations (such as SharePoint Lists) as input to form fields. 

In this walkthrough we have covered just some of the features available within InfoPath 

2010 that can be utilized in building composite solutions.  The ability to design custom 

interfaces with an intuitive tool such as InfoPath Designer 2010 extends the ability of 

power users to create their own composite SharePoint solutions while avoiding the need 

for custom development work.  These new features provided a way for Erika to easily 

create custom solutions for her project team without having to involve developers 

and/or additional resources. 
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Walkthrough 7: Search  
Enterprise search capabilities are often one of the most significant areas of Return on 

Investment (ROI) for companies using SharePoint. FAST Search is a high-end enterprise 

search engine delivered through SharePoint that enables users to quickly create a visual 

search experience that takes into account the context of diverse groups of users.  For 

organizations, using FAST Search means that project managers could perform the same 

search as a sales associate, but because each group uses and views information 

differently they would see different results. These types of changes can be made quickly 

through the SharePoint user interface. 

Refining Search Results with Filtering 

Erika remembers seeing a PowerPoint presentation a few months ago that contained 

the total number of different gears the company makes.  She thinks this information will 

be useful to her team, but she isn’t sure where it’s stored in SharePoint.  She heads to 

the FAST Search Center since she knows she will be able to quickly locate the document 

using the advanced search features.   

1. Navigate to the home page of the site.  In the top navigation, click Search to open 

the FAST Search Center.  

 

2. Type Gears in the search box and press enter. 

 

3. Look through the results.  Notice the image at the top of the page, along with a star 

next to the word Gears, followed by a brief description. This is a visual best bet that 
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was predefined by the search administrator to aid users that are searching for gears. 

 

4. New to the Search experience in SharePoint 2010 is the refinement panel in the 

Quick Launch area, which can be used to filter and drill down on search results.  

Since Erika knows she is looking for a PowerPoint document, click Microsoft Powe… 

to refine the results. 
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5. Scroll through the results and find Contoso Company Facts.pptx. Below the search 

result, click the Preview link. 

 

  

6. Using the preview feature, scroll through the slides.  Notice that “We make 102 

different gears” is stated in the third slide.  You were able to view this information 

without even opening the presentation.   

 

 

Advanced Searching in SharePoint 2010 

Erika would now like to find any documents that have information on both Great White 

Gears and Vulcan Gears. Her first challenge is figuring out how to spell “Vulcan”. Luckily, 

SharePoint 2010 has the capability to perform advanced searches, such as wildcard and 

Boolean.  
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1. In the search box, type Vu* and press Enter.  Notice that all the search results 

starting with “Vu” are displayed, including “Vulcan.” 

 

2. In the search box, type Vulcan AND “Great White” and press Enter.  This performs 

a search for documents that contain both of the terms “Vulcan” and “Great White.”  

By putting quotation marks around Great White, it is treated as a single term instead 

of the two separate words, “great” and “white.” 
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3. Notice that documents containing both of these terms are displayed in the results. 

This walkthrough has shown just a brief summary of the functionality available when 

FAST Search is incorporated into your SharePoint environment.  We have covered some 

of the different features such as Keywords, Best Bets, search refinement, wildcard, and 

Boolean searches.  Erika was able to use these features to quickly find information and 

documents for her project team. 
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Conclusion 
Now that you have completed all of these walkthroughs, you have seen many of the 

new, rich features included in SharePoint 2010.  You have seen how easily a site can be 

created and customized for both style and content, as well as how easily content can be 

incorporated from other line-of-business systems.  Many tasks that would have 

traditionally required assistance from IT and taken extended periods of time to 

implement can now be created in a fraction of the time with SharePoint 2010.  These 

walkthroughs have shown just how easy it can be for business users, empowered with 

the right tools, to build rich, dynamic business solutions.  But this document is just a 

sampling of the new features available within this release.  To keep up to date on all the 

new features within SharePoint 2010, you can visit the Microsoft SharePoint 2010 web 

site at http://sharepoint2010.microsoft.com.  The site contains the most up to date 

resources to help you learn about all the new features SharePoint 2010 has to offer.  

Learning More 
To learn more about SharePoint 2010, see the following resources: 

 Microsoft SharePoint 2010 (http://www.microsoft.com/sharepoint)  

 SharePoint Server 2010 Evaluation Guide for Technical and Business Decision 

Makers (http://go.microsoft.com/?linkid=9727161) 

 Microsoft SharePoint Server 2010 Evaluation Guide For IT Professionals 

(http://go.microsoft.com/?linkid=9727162) 

 Microsoft SharePoint 2010 Professional Developer’s Evaluation Guide 

(http://go.microsoft.com/?linkid=9727163) 
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